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Preface 

 

Intended Audience 

 

Prepared for High School and first year students in Architecture and Construction-

related programmes 

Easy Steps to ArchiCAD is designed for students in construction-related programmes. It 

provides an easier means of learning how to draft designs using ArchiCAD software. This 

teaching manual helps you learn to use various tools in ArchiCAD while designing a simple 

residential building. The focus is on providing a good understanding of the major steps 

required to design a building in ArchiCAD. It illustrates basic information in ArchiCAD 

commonly used to design buildings. This manual simulates a real architectural project, in 

detail, and is perfect for everyone who wants easier and more explained steps to the use of 

ArchiCAD for building designs. 

To gain the best out of this resource, you are advised to download ArchiCAD version 22 

Educational version and have the any of the following1: 

Recommended Operating Systems (OS): 

 Windows 10 

 macOS 10.14 Mojave 

 macOS 10.13 High Sierra 

 macOS 10.12 Sierra 

Recommended Hardware: 

 Processor: 64-bit processor with four or more cores 

 RAM: 16 GB or more is recommended; for complex, detailed models 32 GB or more 

may be required 

                                       
1 Graphisoft. Retrieved from https://www.graphisoft.com/support/system_requirements/AC22/ 
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 Hard disk: installing ARCHICAD on a SSD (or Fusion) drive is recommended; 5 GB 

free disk space is required for the installation, 10 GB or more is required per active 

project 

 Graphics card: Dedicated OpenGL 3.2 compatible graphics card with onboard 

memory of 1024 MB or more is recommended to fully exploit hardware acceleration 

capabilities. You can find a list of recommended graphics cards at 

http://www.graphisoft.com/videocards 

 Display: A resolution of 1440 x 900 or higher is recommended 
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About ArchiCAD 
 

ArchiCAD is a drafting software used for Building Information Modelling (BIM) in the 

architecture, construction and engineering industry. It enables designers and architects to 

model a real-life building creating accurate construction details for building elements such 

as steel, timber, reinforced concrete and complex beams and columns. It also enables 

estimators or quantity surveyors to quantify the estimate of these building elements and 

entire projects. 

How to Use this Manual 

This book is divided into four modules. Each module takes you through steps to achieving 

specified drafting steps in ArchiCAD. 

Module 1: In this module, you will be introduced to the design of a building. It presents the 

first steps such as setting up of the drawing template and story levels. 

Module 2: The actual design of a simple one-bedroom residential building is presented in 

this module. It includes all the basic activities required to design the building. It includes 

creating the site mesh, the building envelope and roof. 

Module 3: In this module, the sample building will be completed. It illustrates how to create 

openings, internal structures and foundations for the sample building. 

Module 4: This module deals with the documentation aspect of a building design (working 

drawing). It presents how to create zones, dimension buildings, produce details of building 

components, take off Quantities/Schedules and share your design. 

Videos are embedded in the texts at certain sections of the manual. You are required to 

watch the videos alongside the manual for a demonstration of the steps undertaken to gain 

the complete picture. The contents were produced from Graphisoft ArchiCAD manuals using 

ArchiCAD 22 Educational licence. You will need to register with myarchicad.com for more 

information and instructions on how to get the licence appropriate for you. 
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Exercises are included at the end of each module. These exercises will assist you in 

solidifying the lessons and steps described in the modules. You are advised to attempt all 

exercises provided.
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ArchiCAD Platform 

 

ArchiCAD platform is made of various elements for design. The figure below shows the 

important on screen elements you will be using for design. They are: 

 Menu: It contains the major commands in an ArchiCAD project. It enables you 

manage the file you are working on and provides the various options required to 

manage the objects available to use for the project. Some actions you can do using 

the commands contains in this section open new or existing and save projects, add 

information about a project, import and export objects or files into or from 

ArchiCAD, access solution to common hiccups when using ArchiCAD. 

 Toolbar: This contains commands such as undo and redo commands, pick-up and 

inject parameters from one object to another and show trace reference to a drawing. 

 Infobox: It displays parameters of a tool in use as set up in its settings such as the 

size and height of a wall, the shape and building materials used for a floor slab or the 

materials used in a roof. 

 Navigator: It contains the various drawing screens created in ArchiCAD for the 

project such as Ground floor plan, roof plan, elevations, sections, details, schedules 

etc. It enables you move from one drawing to another. 

 Quick Options: It contains information about the drawing screen active. It enables 

you to modify the paper size, drawing scale and other options for your drawing. 

 Toolbox: It contains the various tools used to design the building. it is divided into 

three sections (Design, documents and More). The Design section contains tools 

used for 3D drawings such as walls, roofs and slabs. The Document section contains 

tools used for 2D drawings such as lines, fill, dimensions and textbox. The More 

section contains others such as lamp, spline and camera. 

 Status bar: The status bar states the next step that is required to perform an action 

using a tool that has been activated. 

 Drawing screen: The drawing screen displays the drawing or building begin 

designed.  
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Noting these elements are essential to the use of ArchiCAD. We will use the tools in these 

elements to carry out the required steps while designing the building.  
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Module 1 - Setting 

Up the Project 
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Module 1 – Setting Up the Project 

Learning Outcomes 

At the end of this module, you should: 

 Be able to set up a project 

 Be able to add required information about the real-life project to your project in 

ArchiCAD. 

 Be able to set up Story Levels and Working Units. 

 Create the building site 

 

Setting Up the Drawing Template  

To set up the drawing template on which you will design your project: 

 Launch the ArchiCAD software and Create a new project by selecting the File > 

New > New command. 
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 Select ARCHICAD 22 Template.tpl from the Template palette 

 Select the Standard Profile 22 from the options in the Work Environment Profile 

dropbox 

 Click the New button. If Save Changes dialogue appears, choose Don’t Save. 

Wait a few seconds for the template to be created 

Tip: 

The template you have produced is a default template. It contains the basic data and tools 

and objects (layers, building materials, composites etc.) you will need in this manual. 

However, you can customise your template to suit your preference. 

 

 Check out the new template. It looks like the one above (ArchiCAD Platform) 

without the building design on it.  

 

 Now that we have created our project, we need to save the file to ensure that we do 

not lose the data we will be adding into the project.  

o Select File > Save As…  
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o Save the file as My ArchiCAD Project (make sure the file type is set to save 

as a .pln) in a location, you can access (e.g. Desktop or Documents). 

 

 Hit Save 

 

Adding Project Information 

Before you begin designing your project, you should add all the information about the 

project into Project Data. 

These are information that identifies the project such as client’s details, site details, your 

company details, consultants’ details if applicable etc. 

This information will be used automatically in the Title Blocks etc.  later on. 

To add the project information; 

 Go to File > Info > Project Info 

 Within PROJECT DETAILS, set: 

o Project Name = My ArchiCAD Project 

o Project Description = Residential Building 

o Project Code = 2019-123 

o Project Number = 01 
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o Project Status = Concept Design 

 Within SITE DETAILS, set: 

o Site name = 01-Site 

o Site ID = 01 

 

 Scroll down to CLIENT DETAILS, and set: 

o Client Full Name = Mr & Mrs John Smith 

 

o Hit OK 

 

 

 



6 

 

 
 

 

 Hit OK 

Tip: 

.pln = The main ArchiCAD file that contains all the information on the project. Always save 

this file as you design. 

.bpn = The backup file. It usually has a red arrow on it. 
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Working Units 

To enable us to design using the appropriate and standard drawing units, we will modify 

the drawing template to suit our preference. To do this: 

 Go to Options > Project Preferences > Working Units  

 

 Set the units as below. 

 

 Hit OK 
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Now, we have created our project and we can begin to design our project. 

Please click on the video below to watch a demonstration 

  

Video 1: Setting up the Project 

Setting up Story Levels 

Story Levels are the horizontal levels that ArchiCAD uses to define the height of building 

floors. Similar to horizontal plane levels used in Architectural plans, they represent the 

height limit for the building head rooms and floors. We also use them to identify the height 

(or depth) of the building site where the foundation of the project will be modelled. 

The Story levels are labelled as Story 0, Story 1, Story 2 etc. 

For a standard single-story building, we would create 3 Stories. 

 Story -1 = Datum or Sea Level (this is where we model the Site Terrain) 

 Story 0 = Ground Floor 

 Story 1 = Roof 

To set the story level: 

 Go to Design > Story Settings or Navigator > Right-click on Stories > Select Story 

Setting. 

By default, ARCHICAD creates the project with 3 Stories. We will change this to suit the 

building we are creating. To do this: 

https://www.youtube.com/watch?v=fq7EzENkBDY
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 Click on 0 Sea Level/Datum to highlight it 

 Click on Insert Below to create a new -1 Story Level after the Sea Level/Datum.  

 Name it as Foundation 

 Select 2 Roof and click on Delete Story to remove this Story Level 

 Rename and set the parameters of the remaining stories as shown in the image 

below: 

 

 Hit OK. 

If the notification below comes up, hit Delete anyway to continue 

 

Creating the Site Mesh 

The site mesh simulates the construction site on which our building will be erected. To 

create the site mesh, we will need to draw the 2D representation of the site and then create 

the terrain. There are two methods to create the site mesh: 
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A. From a DWG file or similar supplied via a Surveyor. With this DWG drawing, we can 

trace around the Boundaries to form the mesh, then use the drafting tools to 

automatically create the 2D representation of the site (boundaries and contours). 

B. From a Certificate of Title (C.T.) obtained from Council that has the boundary 

angles and lengths. Using the drafting tools, we can add the boundary angles and 

lengths, then create the mesh from these objects. 

We will use method B in this instance.  

Method B: Creating the Site Mesh 

For this method, you may follow the instructions from Central Innovation 

https://youtu.be/XlITEExjtmE 

Or you can follow the steps below. Before we begin, we will create the worksheet on which 

our site boundaries and contour lines will be defined. 

The steps are: 

 Open Navigator – click on Project Map 

 Right-click on Worksheets, then select New Independent Worksheet 

 Set Reference ID as W-01, and Name as Site. 

 Click on Create. 

 

 

 

 

 

 

 

 

 

 

https://youtu.be/XlITEExjtmE
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We have just created the 2D worksheet where we will draw the lines for the site boundary 

and contour using the following dimensions: 

 30m x 15m (L x W) 

 Contours at 3m interval from point B 

Height @ a = 1m 

Height @ b = 0.5m 

Height @ c = 0.0m 

To do this, make sure you are on W-01 Site drawing screen 

 Click on the Line tool in the Document toolbox to activate the tool 

 Select the Rectangular Geometry Method 

 Click on the hotspot to start drawing the site. Move your hand up-left on the 

drawing screen to form a rectangle 

 Type 30 in the first distance space in the 

palette box that appears to define the length of 

the site 

 Type 15 in the second distance space to define 

the width of the site (you can use the button on 

your keyboard to move down to the palette) 

 Hit Enter 

Please click on the video below to watch a demonstration 

      

Video 2: Site Boundary 

 

 

https://www.youtube.com/watch?v=8ZCLsZfZH7U
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Now we have defined the boundaries of the site. Next, we will define the contours on site. 

 Pick up a guideline from any side of the drawing screen and place on the vertical 

right edge of the site boundary 

 Hover your mouse over the guideline and click on the orange pick-up spot that 

appears to pick up the guideline 

 Place it 3m left from the edge by typing in 3 in the distance box that appears 

 Pick up the guideline and click on CTRL to add a copy (a plus sign appears net to 

the cursor) 

 Place it 3m left of the guideline (you will notice that a copy of the guideline is 

placed) 

 Repeat the same process to place a third guideline at the same distance from the 

last guideline 

 Click on the Spline tool in More section of the toolbox to activate the tool 

 Click on the intersection between the first guideline and the upper horizontal edge 

of the site boundary 

 Move a distance 5m from the edge of the guideline and hit Enter on your keyboard 

to place the first line of contour ‘a’ 

 Move the cursor toward the left of the drawing screen and type in the next distance 

3m at an angle 20o   

 Hit Enter to place the second line of contour ‘a’. 

 Move further down to the intersection between the guideline and the lower 

horizontal edge of the site boundary and click to place the last line of contour ‘a’. 

 Right-click and select OK to end the contour line ‘a’. 

 Repeat the process to draw contour b and c using the following dimensions: 

o Contour ‘b’:  

 Distance 4m; Angle 90o 

 Distance 6m; Angle 10o 

o Contour ‘c’: 

 Distance 1m; Angle 90o 

 Distance 7m; Angle 15o 
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 Hit Esc to deactivate the Spline tool 

The site boundaries and the contour lines have been created. You can dispose of the 

guidelines as we no longer need them. 

 Change the colours of the site boundaries and the contour line to black pen by 

selecting them one by one (or hold down on Shift and select all the lines at once) 

and choose colour 1 on the Pen box in the Infobox. 

 

Please click on the video below to watch a demonstration 

      

Video 3: Placing Contour Lines 

https://www.youtube.com/watch?v=ilvVDOtGakE
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Modelling the Terrain 

Now we need to model the Terrain Mesh (Site) using the site boundary lines and contour 

lines. The contour lines will be used as base geometry for our terrain mesh. 

Switch to Navigator - Project Map > 0. Ground Floor 

 Right-click the W-01 Site worksheet in the 

navigator and choose Show as Trace Reference 

to have the 2D representation of the site showing 

as a traced view. 

If you cannot see all the lines and dimensions, do this: 

 Click the arrow next to the Trace button in the 

Toolbar and choose Trace & Reference from the 

bottom of the list to open the Trace & Reference 

palette. 

 

 Open the settings of the Reference, check the All Types checkbox and click Apply 

Settings to all References to ensure that the trace will always behave the same 

way. 

 

 Close the Palette 
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Note: If you still cannot see the lines, it could be that their layers are hidden. Open the 

Layer Settings dialog by pressing Ctrl+L, scroll down in the list of layers. Click the eye 

icons for the layers assigned to the lines and dimensions to make them visible. Click OK to 

close the layer settings. 

Now we have the site boundary and contour lines showing as a trace reference on the story 

level 0. Ground Floor where we will model the Site Terrain.  

To create the Site Terrain, first, we need to set the parameters of the Terrain. To do this, 

 Activate the Mesh Tool (click on the Mesh Tool icon in the Design section of the 

Toolbox (on the left) so that it will be 

active) and double-click on its icon to open its settings. 

 The Mesh Settings dialog opens. Set the mesh properties as follows: 

o Geometry and Positioning: 

o Mesh Height: 2.0m 

o Home Story to 0. Ground 

Floor  

o Elevation to Project Zero 

to -0.10 

o Select Solid Body as the 

Structure 

o Select Soil as the Building 

Material 

o Floor Plan and Section: 

o Select Show all Ridges in 

the Ridge selection tab 

o Uncheck Cover Fills in the 

Floor Plan and Section 

panel 

o Model: 

o Override Top Surface with 

Grass – Green 

 

 

 

 

 

Layers 
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o Select All Ridges Sharp for 3D Appearance 

o Classification and Properties Set Structural Function as 

o Non-Load-Bearing Element  

o Position as Exterior. 

o Layers: Des: Site Mesh Proposed 

 Click OK 

NB: If you are going to communicate your design to any engineers who work with 3D 

applications, you have to fill in the fields for Classification and Properties, so the external 

application can recognize them properly. 

From the parameters we have set, our site terrain will be 2 meters high, starting from 0.1 

meters below the Datum. We have selected to have All the Ridges as sharp so that we can 

identify the points where the contours on-site are. The cover fill is unchecked so that the 

site is clear of any graphics since we are working on it.  

Now that we have set the parameters, we can create the terrain. To do this, 

 Select the Rectangular Geometry Method in the Info Box and click the two 

opposite points of the site rectangle (A & C; or B & D) to create a mesh. 

 Hit the Esc button on the keyboard to deactivate the Mesh tool 

Please click on the video below to watch a demonstration 

      

Video 4: Site Mesh 

https://www.youtube.com/watch?v=9CqSCYarJFo
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The site has been created. The next step is to create the contours on site. To do this: 

 Select the mesh with Shift + click or click on any edge in the Mesh  

 Activate the Mesh Tool if deactivated  

 Space + click (hold down the space bar on your keyboard and click with the mouse 

cursor) on the curved level lines (contour lines) one by one to add them to the mesh.  

 Select Fit to User Ridges in the New Mesh Points dialog.                    

 Click OK 

 Hit the Esc button on the keyboard to deactivate the Mesh tool 

To set the height of the points of the mesh that are on the same height level, 

 Select the Mesh and click on a Node of contour ‘b’:  

 When the Pet palette appears, click on Elevate Mesh Point.  

 Set Height to 0.5 and check the Apply to All checkbox, so that all nodes on this line 

will be elevated to the same height.  

 Click OK. 

Repeat this action with the line on the right (contour a) and set the Elevate Mesh Point to 

1.0. 

 Now elevate the two corners of the site (B and C) on the right one by one by clicking 

on the node. 

 Select Elevate Mesh Point again and set 1.0 as the Height but, leave the Apply to All 

checkbox unchecked; otherwise, all points of the rectangle would rise.  

 Repeat this with the corner below (D and C).  
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 With the mesh selected, Right-click and select Show Selection/Marquee in 3D to 

check its shape 

 Click on the Fit in window button in the bottom of the screen if it is not fully visible 

 Go to View and click Editing Plane Display to turn off the editing plane if it is 

displayed 
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Please click on the video below to watch a demonstration 

     

Video 5: Site Contours

https://www.youtube.com/watch?v=sA1XbASULVA
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Exercise 

1. What is the ArchiCAD work environment profile used for the design of the sample 

building? 

a. Standard Profile 20 

b. ArchiCAD Template 20 

c. ArchiCAD Template 22 

d. Standard Profile 22 

2. What is the name of the client for the sample building?  

a. Mr & Mrs Jane Smooth 

b. Mr & Mrs John Smith 

c. Mr & Mrs Josh Snet 

d. Mr & Mrs Steve Smith 

3. What unit of measurement is set as the working unit for the design? 

a. Millimeters (mm) 

b. Meters (m) 

c. Centimeters (cm) 

d. Kilometers (km) 

4. How many story levels were created for the building design? 

a. 5 

b. 4 

c. 3 

d. 1 

5. Which of these options is not a story level used for this building design? 

a. Datum 

b. Foundation 

c. Ground Floor 

d. Roof 

6. What do the story levels represent in a building design? 

a. The height of the head room of a building floor 

b. The height of the doors in a building 

c. The height of the windows in a building 

d. The height of the tallest furniture in a building 

7. The 2D representation of the site boundaries was created using all of the following 
except? 

a. Lines 

b. Guidelines 

c. Worksheet 

d. Site mesh 

8. What are the dimensions of the building site? 

a. 30m x 15m 

b. 25m x 50m 

c. 30m x 40m 
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d. 20m x 10m 

9. What is the height of 0 Ground Floor story level? 

a. 3.00 

b. 3.10 

c.  1.00 

d. 6.00 

10. What is the use of the contour lines? 

a. They define the ground levels on a building site 

b. They represent the heights of the buildings on site 

c. They show the boundaries of the site 

d. They measure the length of the contours on site 

11. Which icon shows a hidden layer in the layer settings? 

a. The eye icon 

b. The trace icon 

c. The freeze icon 

d. The lock icon 

12. What is the height of the site mesh? 

a. 4m 

b. 3m 

c. 2m 

d. 1m 

13. Why is “Show all Ridges” selected from the ridge selection in the Mesh settings? 

a. To ensure that the edges of the contours on site are visible 

b. To ensure that the nodes of the contours on site are visible 

c. To ensure that the site mesh is visible 

d. To ensure that the site boundaries are visible 

14. What is the layer used for the site mesh? 

a. Site Mesh-defined 

b. Site Mesh-Proposed 

c. Structural bearing 

d. Non-load bearing 

15. What geometry method is selected to draw the site mesh? 

a. Polygonal 

b. Circular 

c. Rectangular 

d. Square 

16. What are the heights of contours a, b and c? 

a. 1.0m; 0.5m; 0.0m respectively 

b. 0.0m; 0.5m; 1.0m respectively 

c. 0.5m; 1.0m; 1.5m respectively 

d. 1.0m; 0.5m; 1.5m respectively 

17. What are the angles for drawing the 2D representation of contour b? 

a. 90o & 10o 
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b. 90o & 165o 

c. 90o & 20o 

d. 180o & 10o 

18. Does the site mesh start 1 m below the datum? 

a. Yes 

b. No 

19. What is the top surface material used for the site mesh? 

a. Pavement -Brick Moss 

b. Brick - Finish 

c. Green – Grass 

d. Sand - Gravel 

20. What is the project status for this design? 

a. Documentation 

b. Residential building 

c. Working drawing 

d. Concept design 
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Module 2 - Designing the Building Project 

Learning Outcomes 

In this module, you will model your building. You will create the following elements: 

 Exterior Walls  

 Floor Slab  

 Interior Walls  

 Roof 

As we are modelling in 3D, we need to think about more than simply the length of the 

building elements. We will be considering the height and thickness of the building 

elements we are to design.  This will allow us to get adequate information such as its 

Surface finish; the paint on the interior and weatherboards on the exterior, etc. for the 

building. This is the major difference between a 2D and #D model. 

Creating the Building Envelope 

Before creating the building envelope, which includes the walls, slabs and roof, we will 

need to set the features or materials of the building components. We will also define the 

layers associated with the building components, building materials, composite structures 

and component parameters.   

Creating Layers 

It is good practise to allocate layers to all the building components that will be used in the 

design. The benefit is that we can work on different elements collectively when they are in 

the same layer without affecting other elements in the building. We will now create layers 

for the components we will use in creating the building envelope. 

We need to create the following layers: 

 Structural – bearing for the exterior walls and internal floor slab 
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 Site & Landscaping – Terrain for the external pavement 

 Shell – Roof for the roof 

You must have noticed that we used the layer –Site Mesh Proposed- for the Site Terrain 

we created (refer to Module 1).  This layer was created by default in ArchiCAD. However, 

we will create new layers for the building components listed above. Later on, we will create 

more layers for other building components.  

To create the layers, do the following: 

 Go to Documents > Layers > Layers (Model Views) 

 Select New to create the layers specified above. 

 

 

 Click on OK  

Repeat the process to create the other 2 layers 
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 Hit OK on the Layers (Model Views) when you finish creating the 3 layers’ to close 

the layer settings. 

Note: We can have layer combinations, as shown in the picture above. This allows for 

further manipulations and groupings 

depending on the task we want to carry 

out. You may wish to have a look at the 

various layers created by ArchiCAD for 

your use.  

 

Building Materials – Exterior Wall 

Now that we have created the layers for our building elements, we can start defining the 

individual materials of our building components. For the exterior wall, we will be using a 

White Brick material as the finish material. 

To create this material, 

 Go to Options > Element Attributes > Building Materials.... 

In the upcoming dialog for Building Materials, you can see the list of the building materials 

created by default for use. Each material is simulating a real-life building material and has 

a palette with various options for its characteristics (Structure and Appearance and 

Properties). It also has an “Intersection Priority” setting. This priority setting will control 

how the intersection points of building materials will appear when created and used in the 

building. The higher priority a material has, the more visible it will be at a junction on the 

plan, section or detail of the building. 

Tip: 

Every building component is made up of certain features that differentiate it from others. 

For instance, a wall is different from a window because of the elements it comprises of 

such as insulation, structural elements for load-bearing walls, finish etc.  
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To create a building material, you can either duplicate and edit an existing material or 

create a new one from scratch. To duplicate an existing material: 

 Select any existing material from the options in the dialogue box (we will use Brick 

– Finish in this instance) and click New (in the bottom) to duplicate the existing 

material. 

 In the upcoming dialog choose Duplicate and set a name - Brick - Finish (white) 

and click OK. 

 Change the Cut Fill Foreground Pen colour to 161 and Surface to Brick - White 

Natural. 

  

 

 Leave other specifications as they are and hit OK to close the dialog. 
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Composite Structures 

A building composite structure is made up of several materials that have specific functions 

they perform. We will create the composite form for the exterior walls. To do this: 

 Open Options > Element Attributes > Composites.... 

 Select the composite, which fits the best to the needed skin structure (in this case, it 

is EXT: Stud 140 Thermal Pb) from the dropbox 

 Click Duplicate... and 

set a new descriptive 

name: Exterior Wall;  

 Hit OK 

 Select the 1st skin and 

change its building 

material to Brick - 

Finish (white), by 

pressing the arrow 

button next to the skin 

name and selecting 

Brick – Finish (white) 

from the dropbox. 

Choose Finish as the Skin Type and type in 0.02 as the thickness 

•   Change the 2nd skin’s building material to Insulation - Mineral Hard and thickness 

to 0.01. Choose Other as the skin type 

 Click on Insert Skin to add a new building material to the composite and change 

the 3rd skin’s building material to Masonry Block - Structural and its thickness to 

0.25. Choose Core as the skin type 

 Insert another skin and change the 4th skin building material to Plaster - Gypsum 

with thickness 0.02 and skin type as Finish 
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 Ensure that all the boxes on the left are ticked and that this composite is to be used 

with only walls  

 Hit OK to close the dialogue box 

Please click on the video below to watch a demonstration 

    

Video 6: Creating layers, building materials and composites 

NB: 

Composite skins may represent different structural functions, like load-bearing, finishing 

or others. You can set this up skin-by-skin in the Edit Skin and Line Structure panel. Note: 

Composites can be also assigned to other structures, like slabs and shells. This particular 

structure is typical for walls, but by clicking on the “Use With” icons you can assign the 

composites to other building structures too. Later on, the composite structure will appear 

in the settings dialog of the assigned element types only. 

Defining the Wall’s Settings 

 Switch to Pop-up Navigator - Project Map > 0. Ground Floor and deselect the 

mesh if still selected (Hit Esc). 

 Activate the Wall Tool (in the Design section of the Toolbox) and open its Settings 

dialog (double click on the icon). 

 Set the Wall settings as follows: 

https://www.youtube.com/watch?v=CJuBLTPGmio
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o Set the Wall Top linked to Roof (Home +1) and 1.0 as Top offset to Top 

Linked Story. This function will make sure that the wall height will 

automatically follow story height changes.  

o Set the Bottom offset to Home Story as -0.10, because it will start on top of 

the foundation structure that we will model later.  

o With the Composite Structure selected, choose the Exterior Wall 

composite. 

o Set the Reference Line to Core 

Inside 

o In the Floor Plan and Section 

panel set Floor Plan Display 

as:  

 Show on Stories: All 

Relevant Stories 

 Floor Plan Display: 

Projected with 

Overhead,  

 Show Projection: 

Entire Element. This 

way the entire wall 

will be visible (even 

parts above floor plan 

cut plane) on all 

relevant stories.  

o Open the Classification and 

Properties panel. Set ID and 

Categories as  

 ID: Wall-001  

 Structural Function: Load-Bearing Element,  

 Position: Exterior,  

o Layer: Structural - Bearing 
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 Click OK 

Creating the Wall 

Now we are done selecting the features of the exterior wall for our building project. The 

next step is to create the walls on the site. To do this: 

 Still, with wall tool active, select the Rectangular geometry method 

in the Info Box (click-hold on the arrow to display the options)  

 Draw a rectangular wall 7m x 4m starting from the intersection 7m of boundary A 

& B and 5m of boundary A & D as shown below. Use the guidelines to locate the 

distances. 

For this action, it is highly recommended that the grid display is turned off. To do this, go to 

View > Construction Grid Display. We can turn the grid on again later on if required.  

The site drawing on the W-01 Site worksheet is still showing. To turn it off, click on the 

Trace icon on the Toolbar or use Alt+F2 to deactivate the Trace tool. The traced drawing 

disappears. 

 

 Hit Esc to deactivate the Wall tool 

 Press Fn+F4 on MAC or Ctrl+F5 on Windows to show all in 3D. 

A B 

D C 
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Please click on the video below to watch a demonstration 

    

Video 7: Exterior Walls 

Floor Slab 

As was done for the exterior wall, we will create a composite - Internal Floor Slab. To do 

this: 

 Go to Composite (Options>Element Attributes>Composites) 

 Click on New to create a new composite named Internal Floor Slab 

 Set the parameters as below: 

o 1st Skin:  

 Material: Tile –Floor;  

 Len Pen – 144;  

https://www.youtube.com/watch?v=_x-hJzAhKZs
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 Type – Finish;  

 Thickness – 0.10 

o 2nd Skin:  

 Material: Concrete;  

 Len Pen – 149;  

 Type – Core;  

 Thickness – 0.15 

o 3rd Skin:  

 Material: Insulation-Mineral Hard;  

 Len Pen – 154;  

 Type – Other;  

 Thickness – 0.03 

o 4th Skin:  

 Material: Hard Fill;  

 Len Pen – 154;  

 Type – Finish;  

 Thickness - 0.02 

o Outside/Top: Solid Line; Len Pen 155 

o Inside/Bottom: Solid Line; Len type 157 

If you notice, we do not have the building material – Hard Fill by default as an option. We 

will need to create this material.  

 Close the dialogue box and follow the steps for “Building Materials” to create the 

building material named – Hard Fill. The Surface is Wood – Mahogany Horizontal 

and Cut Fill is Earth. 

 Go back to the Composite – Internal Floor Slab and edit the 4th skin with the 

building material Hard Fill 

 Ensure that all the boxes on the left are ticked and that this composite is to be used 

with Slabs only (click on the others to deselect them) 

 Click on OK to close the dialogue box   
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We will also create a Composite - Exterior Pavement with parameters as below: 

o Ist Skin:  

 Material: Brick Finish;  

 Len Pen – 1 

 Type – Finish;  

 Thickness – 0.02 

o 2nd Skin:  

 Material: Concrete - Structural;  

 Len Pen – 1 

 Type – Core;  

 Thickness – 0.15 

o 3rd Skin:  

 Material: Sand;  

 Len Pen – 1 

 Type – Other;  

 Thickness – 0.03 

o 4th Skin:  

 Material: Gravel;  
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 Len Pen – 1 

 Type – Other;  

 Thickness - 0.15 

o Outside/Top: Solid Line; Len Pen 1 

o Inside/Bottom: Solid Line; Len type 1 

 

Please click on the video below to watch a demonstration 

    

Video 8: Internal floor slab and exterior pavement composites 

Creating the Slabs 

https://www.youtube.com/watch?v=GcwQwR-jEKk
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We will first create the internal floor slab. 

 Activate the Slab Tool from the Toolbox and open its settings 

Set its properties as follows:  

• In the Geometry and Positioning panel: 

o Select Internal Floor Slab as the 

composite structure. 

o Set Reference Plane to Top 

• On the Model panel:  

o Activate Top Override Surface 

with Tiles –Light Brown 

150x150 

 On the Classification and Properties 

panel:  

o Set as Load-Bearing Element 

and Interior 

 Set Layer as Structural-Bearing 

 Click on OK to close the settings 

We can now start creating the floor slabs.  

o Select the Rectangular Geometry Method in the Info Box. 

 Using the Orbit tool , rotate the building so that you can see the 

internal part of the walls on the site.  

 Hit Esc to deactivate the Orbit tool and the slab tool will be activated 

 Hold down the Space bar on your keyboard and move the cursor towards the 

bottom on the exterior side of the walls. This activates the Magic Wand feature 

that can recognise closed contours.  

 Click when the plane indicator turns into darker grey close to the bottom of the 

wall, and the slab will immediately appear in the middle and at a correct elevation.  
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Please click on the video below to watch a demonstration 

    

Video 9: Placing the internal floor slab 

Now continue with creating the exterior pavement on the floor plan view.  

https://www.youtube.com/watch?v=TIGRhyeUV50
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• Switch to Pop-up Navigator - Project Map > Ground Floor 

• Activate the Slab Tool (if deactivated) and set the settings as follows:  

o Set Ground Floor as Home Story and 

Offset to Home Story as -0,05.  

o Choose the Exterior Pavement as the 

composite structure  

o Override the top and side materials 

and choose Pavement - Brick Moss 

and no override for the bottom 

surface. 

o Set the ID and Categories as Non-

Load-Bearing Element, Exterior 

o Choose Site & Landscape - Terrain 

as the layer. 

o Hit OK to close the settings 

 Using the guidelines, locate the distances, 

as shown below: 
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 Select the Polygonal geometry method and draw the exterior 

pavement on the area mapped out with the guidelines, as shown below:  

 

• Open the 3D All window  to see the result.  
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Please click on the video below to watch a demonstration 

    

Video 10: Placing the exterior pavement 

You must have noticed that the exterior pavement covers the interior floor slab. We cannot 

have both in the same space. We need to cut out the space occupied by the floor slab from 

the exterior pavement. To do this, 

 Select the Exterior pavement 

 Activate the Slab tool by clicking on it in the Toolbox 

 Select the Rectangular Geometry Method  from the Infobox and 

draw on the space occupied by the Interior Floor slab. This will cut out the area 

needed. 

 Hit Esc to deactivate and deselect the exterior pavement 

 

 

 

 

 

 

https://www.youtube.com/watch?v=3azbZVMwKAM
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 Please click on the video below to watch a demonstration 

    

Video 11: Cutting the exterior pavement 

If you will notice that the internal floor slab does not flush with the exterior walls, we will 

need to stretch the slabs to correct it. The interior floor slab is situated inside the walls of 

the building and we have set the reference line to “Inside face”.  

 

To extend the floor slabs, do the following: 

 Switch to 0. Ground Floor 

  

https://www.youtube.com/watch?v=E0cq0RShqD8
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 Activate the Slab tool and type in Ctrl + A to select all the slabs on the site (the 

internal floor slab and exterior pavement will be selected) 

 Select the Arrow Tool  from the Toolbox and stretch the four nodes of the 

internal floor slab to meet the outer face of the exterior walls as shown below:

 

 

We will now extend the exterior pavement to create a verandah. To do this:  

• Select the exterior pavement slab and click on the edge of the lower side (this is 

the side we want to extend) 

• Choose the Offset Edge option in the pet palette  

• Extend the slab for 3.05m  
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• The drawing should look like the one below

 

Hit Esc to deactivate all tools and deselect all objects. 

 

Please click on the video below to watch a demonstration 

    

Video 12: Adjusting the internal floor slab 

3.05m 

https://www.youtube.com/watch?v=GtdzNWm4OTo
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Column 

We will now add the columns to the extended pavement.  

• Still on the Ground Floor (hit Esc or click outside the drawing to deactivate or 

deselect any active tool) 

• Activate the Column Tool in the Toolbox.  

• Open the settings dialog and set parameters 

as follows:  

o Column Top: Not Linked  

o Column Height: 3.15  

o Bottom Elevation to Project Zero: -

0.05 

o Structure: Rectangular  

o Size 0.20 x 0.20  

o Building Material: Timber - 

Structural  

o Anchor Point of Core: Middle  

o Classification and Properties: Load-

Bearing Element, Exterior  

o Layer: Structural - Bearing  

• Hit OK to close the column settings 

 Using guidelines, mark the intersection of 

6.875m from the site boundary AD and 0.6m 

from the exterior pavement using the 

guidelines (see the image below) 

 Place another guideline at 0.75m from the other end of the exterior pavement 

 Place a column on the first intersection point 
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 Select the column and multiply it by activating the Multiply command from the 

context menu 

 Right-click and choose the Move > 

Multiply... command. Alternatively, 

you can use the Edit > Move > 

Multiply... menu command (you can 

also use the shortcut Ctrl + U to 

activate this option).  

  Choose Drag as the multiply action 

and enter 3 for the number of copies. 

Now select the Distribute -1 multiply 

method.  

 Click OK. 

 Click on the centre point of the 

column to pick up the copies of the column 

 Click on the intersection on the right to place the 3 new columns. 
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 Hit Esc to deselect the columns 

Delete all dimensions and guidelines on the drawing screen and view your design in 3D. 

 

Please click on the video below to watch a demonstration 

     

Video 13: Adding Columns 

https://www.youtube.com/watch?v=uV275w7Vask
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Roof 

To design the roof for our building project, we have to create a composite - Roof 

Aluminium with the specifications as shown below: 

 

o Ist Skin:  

 Material: Air Space- Frame;  

 Len Pen – 146;  

 Type – Finish;  

 Thickness – 0.03 

o 2nd Skin:  

 Material: Insulation – Plastic Soft;  

 Len Pen – 154;  

 Type – other;  

 Thickness – 0.04 

o 3rd Skin:  

 Material: Membrane – Vapor Barrier;  

 Len Pen – 158;  

 Type – Other;  

 Thickness – 0.03 
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o 4th Skin:  

 Material: Tile- Roof;  

 Len Pen – 150;  

 Type – Core;  

 Thickness - 0.02 

o 5th Skin:  

 Material: Air Space - 

Frame;  

 Len Pen – 150;  

 Type – Core;  

 Thickness - 0.18 

o Outside/Top: Solid Line; Len 

Pen 155 

o Inside/Bottom: Solid Line; Len 

type 157 

 

To design the roof: 

 Switch to the 1. Roof Story in the 

Navigator. 

 Activate the Roof Tool and adjust its 

settings as shown in the image 

o Click on OK to close the roof settings 

• To construct a pitched roof, first define 

its pivot line by clicking on the lower 

internal corners of the exterior wall. 

• Define the direction of the slope by 

clicking above the defined pivot line 

with the eye-shaped cursor. 
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• Draw the perimeter of the roof (which is its projection to the horizontal plane) 

using the external corners of the exterior wall. 

• Hit Esc to deactivate the roof tool 

We now need to create roof eaves for the roof. To do this: 

• Select the Roof created 

• Click a corner hotspot of the selected roof and offset all edges by 0.6m 

 

We also need the roof to cover the pavement and the columns. To do this: 

 Select the Roof and click on the edge of the lower side (preferably the middle 

line at the edge) of the roof. 

 Choose the offset edge option in the pet palette 

 Extend the roof for 3m to cover the columns. 

 View your building in 3D 
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Trimming the Walls to the Roof 

As you can see, the walls do not meet up with the roof because of the sloping angle of the 

roof. As such, we need to trim the walls with respect to the roof. To do this, 

• Go to the 3D/All view and select all walls (activate wall tool and click Ctrl+ A) 

• Open the settings and change the Top offset to Top linked story from 1.00 to 4.00 

• Hit OK to close the settings 

This will extend the walls above the roof 
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To trim off the part of the walls we do not need: 

 Right-click and select Connect> Trim Elements to Roof/Shell or click on the icon 

on the Toolbar 

• Click anywhere on the roof. The empty roof icon turns black if the program finds a 

selectable element. 

• Click on the side of the walls you want to keep (the walls below the roof) 

The parts above the roof will be trimmed off. 

• Hit Esc to deselect the walls 

The walls are now associatively trimmed to the roof. If you change the roof geometry or 

sloping angle, the walls will be updated automatically. 

 

Please click on the video below to watch a demonstration 

   

Video 14: Adding single plane roof 

https://www.youtube.com/watch?v=io_1cai2HwY
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Exercise 

1. Which of these is a major difference between 2D and 3D drawings? 

a. A 2D drawing is for buildings while a 3D drawing is for projects 

b. A 2D drawing represents the length and width of a building while a 3D 

represents the length, width and height of a building 

c. A 2D represents the length, width and height of a buildings while a 3D 

drawing represents the length and height of a building 

d. A 2D drawing smaller than a 3D drawing 

2. What is the benefit of creating layers? 

a. It enables building components within the same layers to be modified 

collectively without affecting the other layers 

b. It enables building components across different layers to be deleted 

individually 

c. It ensures that building components within the same layers are visible 

d. It ensures building components across different layers are visible 

3. What is the layer created for the exterior pavement? 

a. Structural- bearing 

b. Site & Landscaping – Terrain 

c. Shell – Roof 

d. Site Mesh - Proposed 

4. What building material was created for the exterior wall? 

a. Brick – Finish (white) 

b. Brick – Finish 

c. Brick – White Natural 

d. Brick - Core 

5. How many skins does the exterior wall have? 

a. 5 

b. 3 

c. 4 

d. 2 

6. What is the pen colour for the cut fill of the building material: Brick – 

Finish(white)? 

a. 161 

b. 157 

c. 187 

d. 141 

7. What is the thickness of the exterior wall? 

a. 0.30m 

b. 0.35m 

c. 0.20m 

d. 0.45m 

8. What are the dimensions for the exterior wall? 
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a. 7m x 6m 

b. 5m x 7m 

c. 30m x 15m 

d. 7m x 4m 

9. How many skins does the internal floor slab have? 

a. 5 

b. 3 

c. 4 

d. 2 

10. How did we get to the option for Building Materials? 

a. Options > Property Manager > Building Materials 

b. Teamwork > Property Manager > Building Materials 

c. Options > Layers > Building Materials 

d. Options > Element attributes > Building Materials 

11. For the Internal Floor Slab, the top surface was overridden with what material? 

a. Pavement -Brick Moss 

b. Tiles – Light Brown 150x150 

c. Tiles – Dark Brown 300x300 

d. Tiles – Dark Brown 150x150 

12. What geometry method was used to draw the exterior pavement? 

a. Polygonal 

b. Circular 

c. Rectangular 

d. Square 

13. How long was the exterior pavement extended to accommodate the columns? 

a. 3.50m 

b. 3.05m 

c. 35m 

d. 350m 

14. What is the size of the columns? 

a. 0.3x0.2m 

b. 0.3x0.3m 

c. 0.2x0.2m 

d. 0.6x0.6m 

15. How many copies was entered in the “Multiply” dialogue box? 

a. 5 

b. 3 

c. 4 

d. 2 

16. What is the composite structure for the roof? 

a. Roof – Shell 

b. Roof – Mohagamy 

c. Roof- Aluminum 
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d. Roof - Mesh 

17. What is the angle of the roof? 

a. 18o 

b. 20o 

c. 30o 

d. 28o 

18. What is the length of the roof’s eave? 

a. 0.6m 

b. 9m 

c. 0.9m 

d. 6m 

19. What tool was used to make the walls flush with the roof? 

a. Stretch 

b. Drag 

c. Trim 

d. Flush 

20. What is the thickness of the roof? 

a. 0.30m 

b. 0.35m 

c. 0.20m 

d. 0.45m 
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Module 3- Openings, 

Internal structures 

and Foundations 
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Module 3: Openings, Internal structures and Foundations 

Learning Outcomes 

In this module, you will be creating the partition walls, openings (doors and windows) and 

foundations for our sample building. You will create the following elements: 

 Partition walls 

 Doors and Windows 

 Foundation 

Partition Walls 

Partition walls are internal walls that 

separate the use of spaces in a building. 

They are usually non-load bearing walls. 

As this building is a simple one-bedroom 

with toilet and bathroom, we will need 

partition walls to separate the living room 

from bedroom and bathroom. To create the 

partition walls: 

 Switch to Ground Floor on the 

Navigator (Project Map) 

 Create a new layer: Interior 

Partition (Documents - Layers – 

Layer (Model Views) – New) 

 Activate the Wall Tool and set the 

settings as follows: 

o Wall Top linked to 1. Roof 

(Home + 1) 

o Top offset to Top Linked 

Story: 4.00 
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o Bottom Elevation (to Project Zero): -0.1 

o Reference Line Offset: 0.00 (inside face) 

o Home Story: Ground Floor 

o Composite fill: INT: Stud 140 Insul Pb (we are using a composite created 

by default in ArchiCAD) 

o Floor Plan and Section: All Relevant Stories, Projected with Overhead, 

Entire Element 

o Override Outside and Inside Face Surfaces: Paint - Glossy White 

o Classifications and Properties: Wall- 002, Non-Load-Bearing, Interior 

o Layer: Interior – Partition 

 Click on OK to close the wall settings 

 Hit Esc to deactivate the Wall Tool 

 On the Ground floor, place a guideline 1.0m downwards from the interior core 

side of the exterior wall on top (remember how we carried out this step in 

Module 1). 

 Place another guideline 2.4m from the interior core side of the exterior wall on 

the right-hand side 

You may need to zoom in on the drawing to get a clearer view of the core of the wall. 

 Select the Wall Tool from the Toolbox 

 Choose the Straight Single Geometry Method from the Infobox 

 Draw on the guidelines as shown below 
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 Hit Esc to deactivate the Wall tool 

 View the building in 3D. You will notice that the partition walls protrude above the 

roof like in the image below. 

 

 Select the partition walls and Trim them to the roof. 

                

 Hit Esc to deactivate the Wall tool 
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Please click on the video below to watch a demonstration 

   

Video 15: Partition walls 

Entrance Door 

The entrance door leads into the internal spaces in the building and will be placed on the 

exterior wall. To add the entrance door: 

 Activate the Door Tool and open its Settings dialog by double-clicking on its icon 

on the Toolbox or Info box. 

 Type asymmetric in the search field at the top left of the dialog, to find all available 

asymmetric doors. 

 Select the Double Door Asymmetric 22 door object from the result list. 

 Set parameters as follows: 

o  Preview and Positioning panel: 

 Width: 1.50 

 Height: 2.40 

 Anchor: Sill to Story 0 to 0.00 (if this isn’t available, select Relink 

Anchor Story from the roll down list and select Ground Floor) 

 Reveal to Wall Core: 0.00 (To change from Wall Face click on the 

arrow button on the right) 

https://www.youtube.com/watch?v=l4VqcDbWfIA
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 Anchor Point: Side 1 

o On the Hinged Door Settings (you can use the arrows to assess 

the various options) 

 On the Shape option: Set a value of 1.00  

 On the Door Leaf Type option, select a leaf (Style 20) 

 On the Fixtures and Fittings page, uncheck Casing Outside and 

Inside and check Normal threshold.  

 Select No Grid on the Side Panel option. 

o Classifications and 

Properties: D001 (ID), Non-

Load-Bearing Element 

(Structural Function), 

Exterior (Position). 

o Click on OK to close the door 

settings 

 Switch to Ground Floor on the 

Navigator (Project Map) 

 Move the cursor over the lower 

exterior wall segment and place the 

door on the wall, as shown below. 

You may need to zoom into the 

section to see the junction where to 

place the door. 

 Hit Esc to deactivate the Door tool 
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Internal Doors 

The internal doors connect the spaces inside the building and allow for movement through 

the spaces. To place the internal doors, we need to ensure that they are placed on the 

appropriate wall thickness. 

To have the right wall thickness for the door settings dialog, do this: 

 Pick up the 

parameters of the 

partition wall with 

the Pick-up 

Parameters Tool 

(Alt+C). 

 Activate the Door 

Tool and type Door 

in the search field 

— Select Door 22 

from the search 

results.  

 Set the door 

settings as follows: 
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o Anchor Sill to Story 0: 0.00. 

o Anchor: Side 1 

o Classifications and Properties: Non-Load-Bearing Element, Interior. 

o Click on OK. 

We will first place the bathroom door. To do this: 

 Click on the inner junction between the vertical and horizontal partition walls to 

place a door in the horizontal partition, as shown in the image below.  

 Click above the horizontal partition wall to make the door swing inwards. 

Let us place a door swinging into the bedroom. To do this: 

 Place a guideline at the mid-point of the vertical partition wall. 

 Change the Anchor Point for the wall to Center on the Toolbox. 

 Place the second door in the vertical partition wall of the bedroom at the mid-

point of the wall  

 Click on the right side of the wall to make the door swing into the room. 

 Hit Esc to deactivate the Door Tool 

 Add a 0.45m (450mm) wall next to the door on the horizontal partition wall (you 

will need to change the reference line location from inside Face to Core Outside). 

     

 Hit Esc to deactivate the Wall Tool 
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Please click on the video below to watch a demonstration 

    

Video 16: Placing doors 

Living Room Windows 

We will now place the windows in the living room. To do this: 

 Activate Window Tool and open its settings;  

 Type Sliding in the search field; choose 4-Sash Sliding Window 22 from the 

search results. 

 Set the settings as follows: 

o Width: 2.50 

o Height: 2.40 

o Sill to Story 0: 0.10 

o Reveal to Wall Core: 0.05 

o Anchor Point: Side 2 

o Classifications and Properties: Non-Load-Bearing Element, Exterior  

 Click on OK to close the settings 

https://www.youtube.com/watch?v=t6lilrLPHbI
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 Place the living room windows 300mm from the vertical partition wall (use a 

guideline to achieve this).  

 Click above the exterior wall to make the window open inwards 

 Place another window at the midpoint of the left exterior wall. You have to 

change the Anchor point to Center in the door settings.  

 The opening direction is inwards the building 
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 Hit Esc to deactivate the Window Tool 

 

Bedroom Windows 

To place the bedroom windows: 

 Activate the Window Tool and 

open its settings;  

 Type in Sliding in the search 

field; choose 3 Sash Sliding 

Window 22 from the search 

results 

 Set the settings as follows: 

o Width: 2.40 

o Height: 1.50 

o Sill to Story 0: 0.30 

o Reveal to Wall Core: 

0.05 

o Anchor Point: Center  
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o Classification and Properties: Non-Load-Bearing Element, Exterior 

o Click on OK to close the settings 

To place the window, we need to figure out the midpoint of each wall. Use the Line Tool to 

achieve that (If you notice in the image below, I have used blue lines to figure out the 

midpoints of the bedroom walls. You can delete the lines once you are done).  

 Place the bedroom windows at the midpoint of the lower wall and right side wall 

of the bedroom as shown below.  

 The opening direction is inside the building. 

 

 Hit Esc to deactivate the Window Tool 

 

Bathroom Window 

To place the bathroom windows: 

 Still, on the Ground Floor, activate 

Window Tool and open its settings;  

 Type Window 22 in the search field and 

select it from the results. 

 Set the settings as follows: 

o Width: 0.60 
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o Height: 0.60 

o Sill to Story 0: 1.80 

o Reveal to Wall Core: 0.05 

o Anchor Point: Center  

o Classification and Properties: Non-Load-Bearing Element, Exterior 

o Click on OK. 

 Place the Bathroom window anywhere on the right side wall in the bathroom 

area. 

Please click on the video below to watch a demonstration 

     

Video 17: Placing windows 

Roof level window 

We will now place the roof level windows. 

 While the window tool is still active, place a window on the top wall of the living 

room 500mm from the vertical partition wall.  

 Change the Anchor point to the right. 

 Hit the Esc button to deactivate the tool 

 Select the window, right-click on it, and open the Window Selection Settings. 

 Set the Settings as below: 

o Width: 3.00 

https://www.youtube.com/watch?v=UQ_b_Ccp7qk
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o Height: 0.60 

o Sill to Story 0: 4.30 

o Anchor Point: Side 1  

o Reveal to Wall Core: 0.05 

o In the Basic Window Setting, click on Sash Options tab, set as follows: 

 Sash type: Editable grid 

 Panes Number: Vertically: 1; Horizontally: 10.  

 Click on OK. (You will notice that the window disappears on the Ground Floor Story 

level. Go to Roof Story level, and you will see the window). 

 

 View the window in 3D 
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Please click on the video below to watch a demonstration 

    

Video 18: Roof level windows 

https://www.youtube.com/watch?v=l3XjFVeFueM
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Foundations under the Walls 

We are done with the windows and doors for the building. The next step is to create the 

foundation for the building. Remember that foundations are only required under load-

bearing walls and columns to carry the point load from the building to the ground. To do 

this: 

 Revert to the 0. Ground Floor Story level and select all exterior walls (click on the 

first wall, select other walls holding down on the shift-tab on your keyboard). 

 Right Click and click on Wall settings 

 Set the Bottom offset to Home Story as -0.10, to make the walls start from the top 

of the foundation structure that we want to model. 

 Click on OK to close the settings dialogue box 

 Open the -1. Foundation Story Level (If the skins of wall composites are not 

visible, turn on Trace & Reference on the Toolbar to see them). 

 Select all partition walls and set the Bottom offset to Home Story to 0.0 in the 

settings dialogue box to make the partition walls start from the top of the floor slab.  
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 An Information box appears. Click on Continue to acknowledge this function. 

 

 Click on OK. The walls will disappear from the -1.Foundation story. (Note: they are 

not load-bearing walls; so they do not need a connection with the foundation).  

 Activate the Wall Tool and set the settings as follows: 

o Wall Top: Ground Floor 

(Home + 1)  

o Top offset to Top Linked Story: 

-0.10 

o Bottom offset to Home Story: 

0.0 (so that wall height is 

0.90) 

o Home Story:  -1. Foundation 

(Current) 

o Structure: Basic 

o Building Material: Reinforced 

Concrete – Structural 

o Thickness: 0.60 

o Reference Line: Inside Face 

o Reference Line Offset: 0.05 

o Classification and Properties: 

Load-Bearing Element, 

Exterior, Wall 

o  Layer: Structural – Bearing 

o Click on OK to close the settings 
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 Select the Straight Rectangular Geometry Method from the Infobox

 

 Hold down on Space Bar on your keyboard (for a magic wand) and click on the 

inside part of the exterior walls to place the foundation   

 

 Hit Esc to deactivate the Wall Tool 

Foundations under the Columns 

We will now place foundations under the 

columns. 

 Still on the -1. Foundation Story Level 

 Right-click on the Ground Floor Story 

Level in the Navigator and choose Show as 

Trace Reference from the options (we 

want to see the columns). The outlines of 

the building on Ground level will show on 

your current drawing screen.  
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 Activate the Column Tool and use the following settings: 

o Column Top: 0. Ground Floor (Home + 1) 

o Size: 0.50/0.50 

o Top offset to Top Linked Story: 0.01 

o Bottom Offset to Home Story: 0.00 

o Building Material: Reinforced Concrete – Structural 

o Classification and Properties: Load-Bearing Element, Exterior 

o Click on OK to close the settings 

 

 Click on the midpoints of the wooden columns to place the foundations. 

 Untick the trace icon to remove the trace reference  so that you can 

see your drawing as shown below:  
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 View your work in 3D. You are not able to see the Foundation because it is inside 

the Site Terrain.  

 Select the Site Terrain and Right Click> Layers> Hide Layer to hide the Site. 

 It should look like the images below: 

 

 Go to Documents> Layers> Show All Layers to revert to the original view with 

the Site Terrain 
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Please click on the video below to watch a demonstration 

    

Video 19: Placing foundations 

Accessory Elements 

We need to furnish our building with accessories. The accessory elements are contained in 

the ArchiCAD Library 22. The library includes various furniture accessories like beds, 

tables and chairs; sanitary fixtures like toilets and washbasin; site elements like trees, cars 

and human figures; and special building structures like fireplace, ladders and shading 

https://www.youtube.com/watch?v=Q2L-pghcwM0
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devices. There are various accessory elements (Objects) available for use. Check them out 

later on. 

Placing Objects 

We can now start placing objects in the spaces within the building. 

 Navigate to 0. Ground Floor 

 Double Click on Object Tool 

in the toolbox to open 

the default settings 

 Type WC in the search field 

and select WC 22 from the 

search results 

 Set the parameters as 

follows 

o Bottom Offset to 

Home Story: 0.0 

o Home story: 

0.Ground Floor 

(Current) 

o Rotation angle: 270o 

o Classifications and Properties: Non-Load-Bearing Element; Interior 

o Layer: Des: Furniture 

 Click on OK. 

Place the WC 22 in the bathroom area so that it flushes with the internal line of the 

exterior wall, as shown below: 
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You may want to delete the dimension lines to de-cluster the bathroom  

Using the same steps, place the element below in the bathroom: 

 Basin 22 

o Dimension 1: 0.45 

o Dimension 2: 0.30 

o Bottom Offset to Home Story: 0.80 

o Rotation angle: 0o 

 Shower Tray 22 

o Bottom Offset to Home Story: 0.10 

o Rotation angle: 270o 

As you may have noticed, the shower tray clashes with the swing angle for the bathroom 

door. This means that if constructed, the bathroom door (Door 22) opens into the shower 

tray. To remedy this situation, we will change the type of door. To do this, 

 Select the bathroom door and delete it 

 Select the 450mm partition wall and delete it. The bathroom will look like this: 



78 

 

 
 

 

 Double click on the door tool to open its settings 

 Search for Pocket and select Pocket Door 22 from the search results 

 Change the settings with the following: 

o Door width: 0.75 

o Anchor point: Center 

o Dimension Marker: No Marker 

 Click OK 

Place the door on the midpoint of the horizontal wall. The swing position is Right. 

 

Now we will amend the bedroom door too. To do this:  

 Select the Bedroom door and select Mirror from the palette 

 Click on the Center node to mirror the door. This will change the swing of the door 

leaf towards the bathroom wall. 

 Move the door, so that flushes with the bathroom wall 

We need a wardrobe for the bedroom. To create one: 
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 Pick up the parameters of the bedroom wall and draw a new 0.5m wall starting 

from the edge of the bedroom door  

 

 Do not forget to trim the new wall to the roof in the 3D/All view 

Next, we will clean up the drawing screen for the remaining accessories on the building 

plan. To do this: 

 Select each window and door on the plan and change the dimension marker to No 

marker in the Infobox. Also, delete any dimensions on the plan. This will give us a 

cleaner drawing screen to work on.  

Please click on the video below to watch a demonstration 

    

Video 20: Bathroom accessories 

 

https://www.youtube.com/watch?v=D8JSAp7mxAU


80 

 

 
 

Now, we can continue placing the accessories. 

Place the following elements in the Bedroom: 

 Bed 22 

o Bottom Offset to Home Story: 0.00 

o Rotation angle: 180o 

o In the preview window, change the anchor point to the lower right side of 

the bed 

 Wardrobe Variable 22 

o Bottom Offset to Home Story: 0.00 

o Dimension 1: 1.75 

o Dimension 2: 0.50 

o Rotation angle: 90o 

o In the preview window, change the anchor point to the lower left side of 

the wardrobe 

 Stool 22 

o Rotation angle: 0o 

o In the preview window, leave the anchor point at the center 

o Place the stool next to the bed 

 Desk 22 

o Bottom Offset to Home Story: 0.00 

o Dimension 1: 0.75 

o Dimension 2: 0.60 

o Rotation angle: 90o 

o In the preview window, change the anchor point to the upper right side of 

the desk 

 Chair 03 22 

o Bottom Offset to Home Story: 0.00 

o Rotation angle: 90o 
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o In the preview window, leave the anchor point at the lower middle point 

 Vase 22 

o Bottom Offset to Home Story: 0.45 (same as the height of the stool) 

o Place it in the center of Stool 22 

 Hit Esc to deactivate the Object Tool 

 

Please click on the video below to watch a demonstration 

    

Video 21: Bedroom accessories 

https://www.youtube.com/watch?v=XdB85oDhtSA
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Let us place elements in the Living Area. To place kitchen cabinets, use the following 

objects: 

 Refrigerator 22 

o Rotation angle: 0o 

o Change the Anchor point from Top Center to Top Right side in the preview 

window 

o Click OK 

o Place Refrigerator 22 in the corner next to the partition wall and the 

exterior wall 

 Cabinet Base Triple Door 22. In its settings, use: 

o Rotation angle: 0o 

o Change the Anchor point from Top Left to Top Right side in the preview 

window 

o Click OK 

o Place the cabinet next to Refrigerator 22 

 Range Electric 22. In its settings, 

o Select Oven Rack and Choose the four heating tops (as shown below) 

 

o Rotation angle: 180o 

o Change the Anchor point from Top Center to Top Right side in the preview 

window 

o Click OK 

o Place Range Electric 22 next to Cabinet Base Triple 22 
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 Dining Table 02 22 

o Rotation angle: 270o 

o Change the Anchor point from Top Left to Center in the preview window 

o Click OK 

o Place the dining in the Living Area as shown in the figure below 

 Chair 10 22 

o Rotation angle: 0o 

o Change the Anchor point from Top Left to Center in the preview window 

o Click OK 

o Place four chairs on each side of the Dining Table. 

 Designer Sofa 02 22 

o Change the Anchor point from Bottom Left to Bottom Right side in the 

preview window  

o Rotation angle: 270o 

o Click OK 

o Place the sofa in the corner next to the partition wall and the exterior wall 

as shown in the image below 

 Designer Table 03 22 

o Rotation angle: 270o 

o Click OK 

o Place the table next to the sofa 

 Hit Esc to deactivate the Object Tool  
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Please click on the video below to watch a demonstration 
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Video 22: Living area accessories 

 

To complete our design, let us add an extra door to the kitchen area: 

o Type: Metal Door 

o Anchor point: Side 2 

o Door swings outside to the left of the exterior wall 

 

 

Have some fun adding other site improvement accessories such as cars, trees, people etc. 

Add at least two different items on the site. View your model from different angles. Use the 

Orbit icon to do so or press O on your keyboard to activate the Orbit Tool. 

 

https://www.youtube.com/watch?v=XDYBc_VNs4A
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Now our building design is complete. Well done!! 

Please click on the video below to watch a demonstration 

    

Video 23: Site Improvement 

https://www.youtube.com/watch?v=NxoW5PIJy5w
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Exercise 3 

1. Are the partition walls load-bearing walls? 

a. Yes 

b. No 

2. What type of door was used for the entrance door? 

a. Door 22 

b. Double Door 22 

c. Sliding Door 22 

d. Double Door Asymmetric 22 

3. What door leaf type was used for the entrance door? 

a. Style 1 

b. Style 40 

c. Style 20 

d. Style 30 

4. Where is the Anchor Point for the internal door to the bedroom? 

a. Side 1 

b. Side 2 

c. Center 

d. Bottom 

5. What is the size of the internal doors? 

a. 0.90x1.80 

b. 2.40x1.80 

c. 0.90x2.10 

d. 2.10x2.40 

6. What is the size of the living room windows? 

a. 2.50x2.40 

b. 1.80x2.40 

c. 1.50x1.80 

d. 2.50x1.80 

7. Where is the Anchor Point for the living room windows? 

a. Side 1 

b. Side 2 

c. Center 
d. Bottom 

8. Which tool was used to identify the midpoint of the bedroom exterior walls? 

a. Line Tool 

b. Spline Tool 

c. Guidelines 

d. Copy Tool 

9. What are the pane numbers for the roof level windows? 

a. Vertically: 11; Horizontally: 10 

b. Vertically: 10; Horizontally: 1 
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c. Vertically: 10; Horizontally: 11 

d. Vertically: 1; Horizontally: 10 

10. What is the layer for the foundations? 

a. Structural- bearing 

b. Site & Landscaping – Terrain 

c. Shell – Roof 

d. Site Mesh - Proposed 

11. On which story level was the roof level windows found? 

a. Ground floor 

b. Roof  

c. Foundation 

d. Datum 

12. What is the size of the foundation columns? 

a. 0.50x0.50 

b. 0.20x0.20 

c. 0.30x0.30 

d. 0.45x0.45 

13. How did we get to the option to hide layers on the drawing screen? 

a. Right click > Layers > Hide layers 

b. Left click > Layers > Hide layers 

c. Options > Building elements > Hide layers 

d. Options > Element attributes > Hide layers 

14. What type of door replaced the bathroom door? 

a. Door 22 

b. Double Door 22 

c. Sliding Door 22 

d. Pocket Door 22 

15. What is the rotation angle for the WC? 

a. 270o 

b. 180o 

c. 90o 

d. 45o 

16. Where is the Anchor point for the Cabinet Base Triple Door 22? 

a. Top left 

b. Top right 

c. Center 

d. Bottom right 

17. What type of door was used in the kitchen area? 

a. Timber door 22 

b. Door 22 

c. Metal door 22 

d. Double door 22 

18. What tool is used to placed accessories in the building? 
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a. Object tool 

b. Accessories tool 

c. Furniture tool 

d. Chair tool 

19. What are the building material for the foundation walls? 

a. Brick 

b. Concrete -structural 

c. Structural bearing 

d. Reinforced concrete - structural 

20. How many accessories were placed inside the building? 

a. 15 

b. 17 

c. 20 

d. 19 
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Module 4 - 

Documentation 
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Module 4 -  Documentation 

Learning Outcomes 

In the last three modules, you have modelled a complete building. However, in order to 

present your design to stakeholders, you need to represent them in an orderly and 

sequential manner to convey the required information about the building. In this module, 

we will begin the documentation and the final part of a building design. You will learn how 

to do the following: 

 Divide the building into zones 

 Produce details of building components 

 Take off Quantities/Schedules 

 Dimension important elements 

 Publish your design 

Zones 

For easy identification, rooms in a building are 

often represented in ArchiCAD as Zones. The 

benefit of this is that we can assign common 

properties to multiple zones and edit them in bulk 

if required. Zones are 3D symbols of rooms and 

can be arranged and defined by Zone Categories. 

You will be creating zones for the living room, 

bedroom and bathroom. To create Zones, do the 

following: 

 Navigate to the 0. Ground Floor 

 Activate the Zone Tool  and open its 

settings 

 Set the parameters are follows: 
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o Zone Category: 

BUILDING 

o Zone Name: Living 

Room 

o Zone Top: 1. Roof 

(Home+1) 

o Top offset to Top Linked story: 4.00 

o Bottom Elevation to Project Zero: 0.00 

o Geometry Method: Inner edge 

o Floor Plan 

 Activate Add/Remove Cover Fill 

 Select Carpet for the cover fill type 

o Settings 

 In Content 1: 50, delete all options and leave only three (3) for: 

 Zone Name 

 Zone Area 

 Zone No. 

 In Appearance 1: 50, select the first Frame Style 

o Layer: Des: Zones 

 Click on OK 

 Click anywhere in the living area to identify the zone.  

 To place the text, click on the area you want it to be. 

Repeat the steps to create zones for the bedroom and bathroom with the following 

information: 

Bedroom: 

 Zone Name: Bedroom 

 Floor Plan: 

o Cover Fill Type: Plank Floor 
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Bathroom: 

 Zone Name: Bathroom 

 Floor Plan: 

o Cover Fill Type: Grid 300x300 

The cover fills for the floor finishes of the zones are not showing. To remedy this, go to 

Document> Graphics Overrides. You will notice that by default, the “Zones – no fills” is 

active. Click on “Drafting” to change the settings. The cover fills for the floor finishes will 

appear. 

 

 Hit Esc to deactivate any active Tool  

Please click on the video below to watch a demonstration 

    

Video 24: Adding Zones 

https://www.youtube.com/watch?v=PLlu9K7It10
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Sections  

Sections show the internal view of the building when sliced into two. Depending on which 

part the designer wants to show, they can be cut horizontally and vertically. For this 

building, you will be cutting one vertical section. To do this: 

 Navigate to 0. Ground Floor 

 Activate the Section Tool on the Toolbox (in the Document section)  

 Place a vertical guideline in the 

middle of the bathroom 

 Draw a section along the guideline 

across the building (an eye cursor 

appears) 

 Click on the right-hand side to 

indicate the view of the building 

you want to represent. 

 Select the section line and open its 

settings 

o In the Marker Text Style: 

 Change the Text Height to 

5.0mm 

o In the Marker Symbol and 

Text: 

 Choose Triangle 2 as the 

Marker Style 

 Choose Always 

Horizontal as the 

Marker Text Rotation 

o Click on OK 

 Click on Sections (in the navigator map) 
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 Using the Pick-Up parameters, create a second section horizontally across 

the building.  

 

 Select the section line and change the ID and Name to B Section B (in the 

Infobox)  

 

 Double click on A Section A to view the Section you just created 
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Double click on B Section B to view the Section you just created 
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Please click on the video below to watch a demonstration 

    

Video 25: Sections 

Details 

Details are an important part of the documentation. They represent how building 

components work together in a particular section of the building. They are usually referred 

to when building are constructed. We will create the detail for a part of the building 

component. 

 Still, on B Section B view, activate the Detail Tool .  

 Select the Rectangular Geometry Method 

 Draw a rectangle around the foundation and wall connection, as shown below. 

https://www.youtube.com/watch?v=XDJdVt9tY_0
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 Click above the top-left corner to place the marker 

 Click on Details (on the Navigator Map)  

 Double click on D – 01 Detail (Drawing) to view the 

detail you just created 

If you notice that the connection between the exterior wall 

and the foundation wall is hidden by the interior floor slab, 

then we need to correct this. To do so: 

 Go to B Section B view and select the interior floor 

slab 

 Go to Options > 

Element Attributes > 

Building Materials 

 Change the Intersection 

Priority for Concrete – 

02 to 600 

 Click on OK 

Repeat these steps on the 

Exterior Pavement and change 

the intersection priority for 
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Concrete – 02 building material to 600 

The connection between the exterior wall and the foundation wall becomes visible on the 

section 

 Return to D-01 Detail (Drawing) view 

 Right-click and choose Rebuild from Source View from the options 

The connection between the exterior wall and the foundation wall becomes visible on the 

detail as shown below: 

 

The detail you have produced is incomplete. You need to label the building elements 

shown. To do this: 

 Activate the Label Tool on the Toolbox  and open its settings 

 Change the Font Size to 1.0mm 

 Change the Arrowhead Size to 1.0mm 

 Change the Pointer Starting Angle to 0.0o 

 Click on OK 

Now you can start labelling the elements on the detail 

 Click on the element you want to label (a Text box appears) 

 Type in the description of the element in the box 

 Click to place the label 
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 Click on a node on the label and move it to align with the guideline 

 Repeat these steps to label all the elements as shown in the diagram 

 

You can adjust the labels as you wish using the guidelines (the guideline will enable you to 

place the labels on a straight line). Dispose of the guideline when you are done. 

 Hit Esc to deactivate any active Tool  

 

Please click on the video below to watch a demonstration 

    

https://www.youtube.com/watch?v=z8i75r2GIzU
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Video 26: Details and labels 

Dimensions 

The next step is to put dimensions on the building. Dimensions are an important part of 

documentation. In ArchiCAD, 

dimensions can be linked to reference 

points and chains that will enable any 

changes made on the design to be 

updated automatically. This means 

that if you change the position or 

geometry of the dimensioned element, 

the dimension points and chain will 

update immediately. Dimensions can 

be created: 

1. Automatically or  

2. Manually 

Let us create automatic dimensions 

for the Floor Plan: 

 Create a new layer: 

Dimensioning   

 Navigate to 0. Ground Floor 

 Activate the Wall Tool and 

Select all walls (use 

Ctrl/Cmd+A to do so) 
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 Hold down on Shift and Click on the four foundation walls around the exterior 

walls to deselect them (we do not want to include the foundation walls in the 

dimensioning). 

 Activate the Dimension Tool  and open its settings (you can double click on the 

tool to achieve this) 

 Set the parameters as follows:  

o Dimension Type: 

 Dimension Type: Linear Method 

 Witness Line: Sized Height 

 Font Size: 2.00mm (you can increase the font size if you wish to 

make the dimensions visible) 

o Marker and Witness Line 

 Marker Size: 1.00mm 

o Pointer 

 Arrowhead size: 1.00mm 

o Dimension Details 

 Under Automatically dimension walls and slabs, Check Core Faces 

 Layer: Dimensioning 

 Click on OK to close the settings 

Since this is automatic dimensioning, we will use 

the features provided by ArchiCAD.  

 Go to Document> Annotation> 

Automatic Dimensioning> Exterior 

Dimensioning (If the layer notice comes 

up, click Show layer to continue) 

 Take a look at the available dimensioning 

settings. Ensure the following options are 

checked: 

o Opening Endpoints 
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o Wallhole Size for Doors and Windows 

o Dimension Walls by: Outer Faces 

o Distance Between Dimension Line: 0.50 

o Check Place Dimensions on Four Sides 

 Click on OK to close the dialogue box                   

 Click on the two edges of an exterior wall to define the direction for dimension 

lines. This can be horizontal or vertical. The cursor changes to a hammer icon. 

 Click at a distance away from the building to place the first dimension line. The 

other two dimension lines will be placed automatically at an equidistance (0.50m) 

from the first. 

The dimension lines will be placed on all 4 sides of the building automatically, based on the 

center of the selected building. 

Delete the last row of dimension lines on each four sides (they are duplicates; so, we do not 

need them). Now we have only 3 rows of dimension lines. 

We will use Manual Dimensioning for the Columns and Exterior Slab. To do this: 

 Activate the Dimension Tool 

 Zoom into the drawing so that you can see the columns clearer 

 Click on both edges of each column 

 Double click to indicate placing the dimension lines 

 Click on a space to place the dimension line above the columns 

 Dimension the exterior pavement behind the building as shown below: 



104 

 

 
 

 

In case you click on a point you had not intended to accidentally and do not wish to include 

that point into the dimension chain, simply click on that same point again, the marker will 

disappear.  

Please click on the video below to watch a demonstration 

    

Video 27: Dimensioning 

https://www.youtube.com/watch?v=46C2NoLCKKA
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Schedules 

Schedules provide the characteristics of the elements used to construct a building such as 

the dimensions, orientation and building materials. In ArchiCAD, schedules are predefined 

using the elements you have used to design the building. It provides intelligent, two-way 

communication medium between the schedules and the design project to ensure that even 

last-minute changes will be accurately and consistently reflected in the model and layouts. 

To view the schedules, predefine by ArchiCAD, 

 Navigate to 0. Ground Floor 

 On the Project Map, go to Schedules> Element> 

All Openings Schedule 

 Double Click to open the page. You will see all the 

windows and doors you have used on the building. 

Take a look at the features displayed (Full Element 

ID, Opening Name, Quantity, etc.) for each element.  

This information is essential for the Quantity Surveyor and 

Construction Manager and is useful when elements are to 

be procured for construction work. 

 On the left-hand side, formatting options are available to edit the arrangement of 

the fields to your preference. 

 On the right-hand side, is the displayed Schedules 
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NB: You can customise the schedule to suit your preference using the Scheme settings. Any 

changes you make on the Schedule is automatically updated on the model and vice versa. 

You can view the Schedule of other elements used for the building design. For instance, the 

Bill of Quantities provides the features for all the walls, slabs, roof and columns used for 

this building.  

Placing Views on Layout 

In the design process, you have to communicate your ideas with the other stakeholders in 

the project, like the owner, engineers and constructors. All of these usually need different 

formats that are suited to their applications. ARCHICAD provides users with efficient and 

fine-tuned publishing procedures. 

We will start by creating the layout book where we will place the drawings we want to 

share. To do so; 

 Click on the Layout Book icon of the Navigator  
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 Move the Roof Plan to the position under the Ground Floor Plan to make it A103 

Roof Plan 

 Click on A101 Site Plan 

 Change the Master Layout from A1 Landscape to A3 Landscape in the Properties 

tab 

 Click on A102 Ground Floor Plan and change 

the master layout to A3 Landscape  

We will now start placing the drawings on the layouts 

we have prepared. We will start with the Site Plan. 

 Double Click on A101 Site Plan Layout (you 

should see an empty layout waiting for a 

drawing to be placed on it) 

 Delete the drawing (a box) that is shown on the layout 

 

 Click on the Project Map 

 Double Click on 0. Ground Floor to show the building on the site  

We do not want everything on the Ground Floor plan to be on the Site plan, so we will hide 

some of the objects. To do so: 

 Go to Documents> Layers> Layer (Model Views) and hide the following layers: 

o Des: Furniture 
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o Des: Zones 

o Dimensioning 

o Doc: Elevation 

o Doc: Sections 

o Shell- Roof 

o Site & Landscape Terrain 

 

 Click on OK to close the settings 

All the layers disappear except the columns and walls 

 Select the Fill Tool from the Tool Box (Documents) 

 Opening it’s setting and Set the parameters as follows: 

o Fill Category: Double 1:4 

o Fill Foreground Pen: 1 

 Click on OK to close the settings 

 Place four guidelines along the corners of the building and column to envelope 

them 

 Draw a fill over the building and column as shown below 
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 Right-click on an empty space in view and select Save View and Place on Layout 

(make sure you can see the entire site) 

This takes us to the layout view A101 Site Plan 

 Place the drawing on the hotspot at the center 

of the Site plan layout 

The drawing is too big. Let us adjust it to fir into the 

layout. To do this: 

 Zoom out and select the drawing 

 Open the setting of the Drawing and set the 

parameters as follows: 

o Drawing Name: Custom: Site Plan 

o Drawing Scale: 1:100 (under Size and 

Appearance)  

 Click on OK 

 Move the drawing and place it correctly on the 

layout as shown below 
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Please click on the video below to watch a demonstration 

     

Video 28: Placing site plan on layout 

The next is the Ground Floor Plan 

https://www.youtube.com/watch?v=yt314wXK3WQ
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 Still on the Layout Book tab, Double Click on A102 Ground Floor Plan to show 

the layout  

 Delete the drawing that is on the layout 

 Navigate to 0. Ground Floor on the Project Map 

 Select and Hide the Fill on the Floor Plan, and dispose of the guidelines 

 Go to Documents> Layers> Show All layers to show all the layers we hid 

 Adjust the four Elevation lines so that they touch each other 

 Right-click on an empty space in view and select Save View and Place on layout 

(make sure you can see the entire site) 

 Place the drawing on the hotspot at the center of the Ground floor Plan layout 

To modify the drawing: 

 Zoom out and select the drawing 

 Adjust the nodes so that the entire site is shown 

 Open the setting of the Drawing and set the parameters as follows: 

o Drawing Name: Custom: Floor Plan 

o Drawing Scale: 1:100 

 Click on OK 

 Click on any edge of the drawing to bring up the pet palette 

 Select the Offset Edge Tool and adjust the drawing only show the floor plan 

 Move the drawing and place it correctly on the layout as shown below 
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Please click on the video below to watch a demonstration 

   

Video 29: Placing floor plan on layout  

The next is the Section 

 Still on the Layout Book tab, Double Click on A201 Sections to show the layout  

 Delete the drawing that is on the layout (if any) and change the Layout size to A3 

Landscape 

https://www.youtube.com/watch?v=ULyrkuzIvc4
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 Navigate to A Section A on the Project Map 

 Right-click on an empty space in view and select Save View and Place on Layout 

(make sure you can see the entire site) 

 Place the drawing on the Section layout 

 Repeat the same step and place B Section B on the Section layout 

 Check that it looks like the image below 

 

Please click on the video below to watch a demonstration 

    

Video 30: Placing sections on layout 

https://www.youtube.com/watch?v=xJqjmZznATM
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The next is the Elevations 

 Still on the Layout Book tab, Double Click on A301 Elevations to show the layout  

 Delete the four drawings that are on the layout 

 Navigate to E-01 North Elevation on the Project Map 

 Right-click on an empty space in view and select Save View and Place on Layout 

(make sure you can see the entire site) 

 Place the drawing on the Elevation layout 

 Change the scale to 1:50 (if it is in 1:100) on the Infobox 

 Follow the same steps for E-03 South Elevation 

 Check that it looks like the image below 
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 Right-click on A3 Elevations Layout Subset and choose New layout 

 Set the parameters as follows: 

o Layout Name: Elevations 

o Master Layout: A3 Landscape 

 Click on Create 

 Navigate to E-02 East Elevation 

 Right-click on an empty space in view and 

select Save View and Place on layout 

(make sure you can see the entire site) 

 Place the drawing on the Elevation layout 

 Follow the same steps for E-04 West 

Elevation 

 Check that it looks like the image below 
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Please click on the video below to watch a demonstration 

   

Video 31: Placing elevations on layout 

The next is the Detail 

 Still, on the Layout Book tab, Double-click on 

A401 Detail to show the layout  

 Delete the drawing that is on the layout (if any) 

 Navigate to Detail Drawing on the Project Map 

 Right-click on an empty space in view and select 

Save View and Place on Layout (make sure you 

can see the entire site) 

 Place the drawing on the hotspot at the center of 

the Section layout 

 Select the drawing and change the settings as 

follows in the Infobox: 

o Drawing Scale: 1:10 

 Click on OK to close the settings 

https://www.youtube.com/watch?v=voFgpp7uJ-U
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The next is the Schedule 

 Right-click on A5 Schedules Layout Subset and choose New layout 

 Set the parameters as follows: 

o Layout Name: Schedules 

o Master Layout: A3 Landscape 

 Click on Create  

 Right-click on the new layout -A501 Schedules and select Place Drawing  

 Scroll down and select All Openings Schedule and click on Place 

 Move the drawing to place it appropriately on the layout 
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Please click on the video below to watch a demonstration 

    

Video 32: Placing details and schedules on layout 

The next is a 3D Perspective of the building 

 Still on the Layout Book tab, Double Click on A701 Perspective to show the layout  

https://www.youtube.com/watch?v=SQBQJCrbz_Y
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 Delete the drawing that is on the layout (if any) and change the master layout to A3 

Landscape 

 Navigate to Generic Perspective on the Project Map 

 Using the Orbit Tool, orbit the building to a desired view 

 Right-click on an empty space in view and select Save View and Place on Layout 

(make sure you can see the entire site) 

 Place the drawing on the hotspot at the center of the Section layout 

 Click on an edge of the drawing to bring up the pet palette 

 Select the Offset Edge Tool and adjust the drawing so that it fits on the drawing 

space 

 Move the drawing and place it correctly on the layout  

 Place a second perspective of the building’s back view on the layout 

 Select both drawings and open the settings 

o Under the Title Tab, choose No Title 

 Click on OK 
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Please click on the video below to watch a demonstration 

    

Video 33: Placing perspective views on layout 

https://www.youtube.com/watch?v=3R-D-3taE0Q
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Master Layout settings 

As you may have noticed, the master layout we have been using is A3 Landscape. By 

default, there are pre-set titles on the Layout, but we can change or create new ones as 

required. 

To do so; 

 Still on the Layout Book tab, Double Click on A3 Landscape in the Masters subset 

In the A3 Landscape Masters view, we have access to its content. We can paste any 2D 

content here including text, fills, lines, images etc. We can also copy and paste these 

elements from one Master Layout to another. 

Texts with # icon at the beginning are called ‘Autotext’ elements. The benefit of using these 

is to retrieve information from the Project Info instead of typing the text manually.  

To edit the Title Block; 

 Select the Title Block, Right-click and select 

Open Source View 

This opens a 2D worksheet where we can edit the 

Title Block 

 Go to File > Info > Project Info 

 Fill in the following information into the 

appropriate columns 

o Project ID: 218.123 CAD 

o Site Full Address: Confidential 

o Contact Company: CAD Class 

o Change the Contact Full Name to 

Your Name (Eziaku O. Rasheed) 

o Contact ID: Your student ID 

(123456789) 

o Contact Email:  Not Available 
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o Contact Web: www.ezzyresearch.com 

o Contact Full Address: 123 No Real Street, Auckland, New Zealand 

o Client Full Name: Mr & Mrs John Smith 

 Click on OK to close the project info dialogue box 

You will notice that the Address stretches outside the text space in the 3rd block. Adjust the 

text box by dragging the nodes. 

 Delete Contact Phone and Mobile Number  

 Select the Text Tool from the Toolbox  and open the settings. 

o Change the font size to 2.50mm 

o Click on OK 

 Double-click on the space next to the Contact Full Address in 

the 3rd block. The Text 

Palette shows up 

 Click on the AutoText icon to activate 

it 

 Select Contact Full Name 

 Click on Add to include this in the title block 

 Click on a space outside the text to place it. 

 Hit Esc to deactivate the Text Tool  

 Select the Text, Rotate and place appropriately in the space 

 Repeat the last 8 steps to place Contact ID in the space next to Contact Full Name. 

 Select both Texts and change their Text Pen colour from 86 to 1 

 

http://www.ezzyresearch.com/
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If you check on all the Layouts we have produced, you will notice that the title blocks have 

been updated to reflect the latest information we added. 

Please click on the video below to watch a demonstration 

     

Video 34: Master layout 

Publishing 

Now we need to publish our work for presentation to other stakeholders. Before going 

forward, please save a copy of your drawings in a safe location. By doing this, we are 

sure that we can always access a complete version of our drawings for further use. To do 

https://www.youtube.com/watch?v=jIZqh22kZQQ
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this, we only need the layouts with the required information about our building design 

namely: 

 Sheet Index 

 Document transmittal 

 Site Plan 

 Ground Floor Plan 

 Sections 

 Elevations 

 Details 

 Schedule 

 Perspective 

 Double click on Cover page to open it and delete the drawing on it.  

 Place a drawing of your choice to represent your work 

 Delete the other Layouts on the Layout Book. We should have 11 sheets to publish.  

Select Delete anyway when the Warning! Tab pops up. If you notice, the A701 Perspective 

changes to A601 Perspective. 

 

 Select the Publisher set “My ArchiCAD Project”  

 Right-click on My ArchiCAD Project and select Publisher Properties from the 

options 

 Set the options as follows: 

o Select Create Single File 

o Path: browse to save on Desktop (or any safe location). DO NOT save in a 

flash drive 

o Format: PDF 

 Click on OK 
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 Double-click on Publish at the bottom of the Navigator 

and wait until the entire documents have been published. 

 

 Close the Publishing palette when it is done.  

 Find the PDF file you have created and view your work. 

 

Please click on the video below to watch a demonstration 

    

Video 35: Publishing in ArchiCAD 

 

Well Done! You have successfully designed a complete building! 

https://www.youtube.com/watch?v=zcvTOWhk7Ok
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Exercise 4 
1. What is the zone category for the living room? 

a. Building 

b. Residential 

c. Concept design 

d. Commercial  

2. What are the three options chosen in the content 1:50 section of the zone settings? 

a. Zone Name; Zone Area, Zone ID 

b. Zone Category; Zone Material; Zone ID 

c. Zone Name, Zone ID; Zone Material 

d. Zone Material; Zone Category; Zone ID 

3. What is the cover fill used for the bedroom? 

a. Plank Floor 

b. Grid 300x300 

c. Carpet 

d. Gravel 

4. What is the area calculated for the bathroom? 

a. 2.30m2 

b. 17.61m2 

c. 6.63m2 

d. 7.54m2 

5. What is the Zone ID for the bedroom? 

a. 005 

b. 003 

c. 004 

d. 002 

6. What is the marker style chosen for the section marker? 

a. No Marker 

b. Triangle 2 

c. Rectangular 2 

d. Square 2 

7. What is the text height chosen for the section text? 

a. 5.0m 
b. 3.0m 

c. 4.0m 

d. 2.0m 

8. How many sections were created? 

a. 5 

b. 3 

c. 4 

d. 2 

9. What number was the intersection priority for concrete changed to in the Building 

materials’ dialogue box? 
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a. 500 

b. 300 

c. 600 

d. 400 

10. What type of dimensioning style was using to add dimensions to the columns? 

a. Automatic 

b. Manual 

c. Conventional 

d. Virtual  

11. What was the distance set between the dimension lines? 

a. 0.2m 

b. 0.5m 

c. 0.4m 

d. 0.1m 

12. How did we view the Schedules for the doors and windows? 

a. Project Map > Ground Floor > Schedules 

b. Layout Book > A102 Schedules > Schedules 

c. Project Map > Element > All Openings Schedule 

d. Schedules > Element > All Openings Schedule 

13. What is the size of the Master Layout used for the documentation? 

a. A1 landscape 

b. A4 Landscape 

c. A3 landscape 

d. A2 landscape 

14. What is the drawing scale for the Detail published? 

a. 1:100 

b. 1:50 

c. 1:20 

d. 1:10 

15. What is the name of the client for the sample building?  

a. Mr & Mrs Jane Smooth 

b. Mr & Mrs John Smith 

c. Mr & Mrs Josh Snet 

d. Mr & Mrs Steve Smith 

16. How many layouts were published? 

a. 10 

b. 9 

c. 11 

d. 8 

17. What tool was used to cover the floor plan on A 101 Site Plan? 

a. Line Tool 

b. Spline Tool 

c. Text Tool 
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d. Fill Tool 

18. What is the drawing scale used for the 3D Perspective? 

a. 1:100 

b. No Scale 

c. 1:50 

d. 1:200 

19. What is the Site Full Address used in the Tile Block? 

a. Confidential 

b. 123 No Real Street Auckland 

c. Not Available 

d. 123456788 

20. What file format was the layouts published in? 

a. .doc 

b. .pln 

c. .pdn 

d. .pdf 
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Notes 
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Answers to the Chapters 

Exercise 

Exercise 1 

1. D 

2. B 

3. B 

4. C 

5. A 

6. A 

7. D 

8. A 

9. A 

10. A 

11. A 

12. C 

13. A 

14. B 

15. C 

16. A 

17. B 

18. A 

19. C 

20. d 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exercise 2  

1. B 

2. A 

3. B 

4. A 

5. C 

6. A 

7. A 

8. D 

9. C 

10. D 

11. B 

12. A 
13. B 

14. C 

15. B 

16. C 

17. A 

18. A 

19. C 

20. A 
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Exercise 3 

1. B 

2. D 

3. C 

4. A 

5. C 

6. A 

7. C 

8. A 

9. D 

10. A 

11. B 

12. A 

13. A 

14. D 

15. A 
16. B 

17. C 

18. A 

19. B 

20. D 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exercise 4 

1. A 

2. A 

3. A 

4. A 

5. D 

6. B 

7. A 

8. D 

9. C 

10. B 

11. B 

12. D 

13. C 

14. D 

15. B 
16. C 

17. D 

18. B 

19. A 

20. D 
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